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Introduction
Purpose of Guide
This QuickBooks Guide covers QuickBooks integration with Tabs3 software. It includes information
on setting up integration and how QuickBooks integrates with Tabs3.
Additional guides for separate software features are also available.
All guides are available on our Web site at:

www.Tabs3.com/support/docs.html

Knowledge Base
You may be referred to additional detailed information located in our Knowledge Base on the
Internet at:

support.tabs3.com

Additional Resources
A comprehensive list of all resources for Tabs3 and PracticeMaster can be found on page 41.
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Integration Overview
Tabs3 can optionally integrate clients, costs, and payments with QuickBooks. Fees and accounts
receivable (A/R) do not integrate with QuickBooks.

Tabs3 Billing to QuickBooks
Integration from Tabs3 Billing to QuickBooks is
automatic. Whenever a client, cost, or payment is
added to Tabs3 Billing, a corresponding customer,
job, or bill is automatically added to QuickBooks
(provided the client or tcode is configured to
integrate with QuickBooks). Journal entries are
automatically created in QuickBooks for costs and
payments in Tabs3 Billing.

QuickBooks to Tabs3 Billing
Integration from QuickBooks to Tabs3 Billing is
performed on demand. Running the Merge
QuickBooks Data with Tabs3 program in Tabs3
Billing transfers all new or changed clients and bill
(cost) entries in QuickBooks to Tabs3 Billing.
The figure to the right provides an overview of what
data integrates between Tabs3 and QuickBooks.
For more detailed information on what does and
does not integrate, see the How Tabs3 Integrates
with QuickBooks section of this Guide (page 26).
For best practices when integrating Tabs3 and
QuickBooks, see the Best Practices section of this
Guide (page 36).
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Terminology Differences
The terminology between Tabs3 and QuickBooks differs for certain fields. The following table shows
the Tabs3 field name and the associated QuickBooks field name.
Tabs3

QuickBooks

Client Name

Customer Name

Work Description

Job Name

Client ID

Account No.

Timekeeper

Sales Rep

Cost

Bill

Credit

Credit Memo

Billing Category Desc

Job Type

Tcode

Class

For a complete listing of field mappings between Tabs3 and QuickBooks, including screenshots, see
the Field Mapping Between Tabs3 and QuickBooks section of this Guide (page 43).

Version Compatibility
Tabs3 Billing integrates with versions of QuickBooks Pro, QuickBooks Premier, and QuickBooks
Enterprise that are currently supported by Intuit. Tabs3 Billing does not integrate with QuickBooks
Simple Start or QuickBooks Online.
Tip: For more information on the versions that are supported, including which versions of
QuickBooks were tested with Tabs3 Billing and any issues, visit Knowledge Base Article R11752,
“Third Party Integration Requirements."
In order for integration to occur, every computer that has Tabs3 installed must also have QuickBooks
installed. Alternatively, QuickBooks Remote Data Sharing (RDS) can be installed (page 40).
In order for integration to occur, every computer on which clients, costs, and payments are added,
edited, or deleted must be able to access the QuickBooks company file. This can be accomplished
via the installed QuickBooks program or via the QuickBooks RDS program (page 40).
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Integration Configuration
Before Tabs3 and QuickBooks can integrate, certain settings must be specified in both Tabs3 Billing
and QuickBooks. It is recommended to back up your data before beginning. Tabs3 and QuickBooks
backups must be made at the same time. If you restore a backup of one system and not the other,
your data may become mismatched.

Multi-user Mode vs. Single-user Mode in
QuickBooks
In order for Tabs3 Billing to access QuickBooks, QuickBooks must be running in Multi-user mode. By
default, QuickBooks is configured to run in Single-user mode.
▶ Switching to Multi-user mode
1. In QuickBooks, from the File menu, select Switch to Multi-user Mode.
2. If a “Create New Users” dialog box is displayed, click No.
3. If a message is displayed indicating that the file can now be used in Multi-user mode, click
OK.

QuickBooks Multi-user Mode Limitations
When running QuickBooks in Multi-user mode, certain activities cannot be performed in
QuickBooks. If you need to perform an activity that can only be performed when QuickBooks is in
Single-user mode, you must first close Tabs3 Billing. Then, before Tabs3 Billing and QuickBooks can
integrate again, QuickBooks must be switched back to Multi-user mode. The following is a list of
activities that can only be performed in Single-user mode.
Note: This list was provided by QuickBooks and is subject to change.
l

Backing up, condensing, converting, rebuilding, restoring, or updating the company data
file.

l

Changing company information, including the closing date.

l

Setting up or changing company preferences.

l

Importing or exporting data.

l

Merging, deleting, or restoring list items.

l

Changing list item fields that interact with other lists.

l

Signing up for QuickBooks Payroll Service.

l

Printing Form 1099-MISC.
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l

Mapping a network drive from within QuickBooks.

l

Defining custom fields.

l

Linking to QuickBooks from TurboTax.

l

Accountant’s review activities.

▶ Switching to Single-user mode
1. In QuickBooks, from the File menu, select Switch to Single-user Mode.
2. If a message is displayed indicating that the company file cannot be closed because Tabs3
Billing is using it, click OK. Close Tabs3 Billing and repeat step 1.
3. A message will be displayed indicating that the file can now be used in Single-user mode.
Click OK.
4. Perform the desired task that requires Single-user mode.
5. Before using Tabs3 Billing again, switch back to Multi-user mode.

QuickBooks Application Certificate
The first time Tabs3 Billing attempts to pass data to QuickBooks, the user will see that a certified
application (Figure 2), Tabs3 Billing Software from Software Technology, is requesting access to a
QuickBooks data file.
l

l

Select “Yes, always; allow access even if QuickBooks is not running”. In the Login as field,
select the desired user. (Note: This option is only available if multiple users are set up in
QuickBooks). Then click the Continue button.
You will then receive a QuickBooks Access Confirmation window (Figure 3). Click the Done
button to complete the request.

Likewise, the first time Accounts Payable Software (APS), or PracticeMaster attempts to pass Tabs3
Billing data (e.g., clients or costs) to QuickBooks, the user will see that a certified application with
the program’s name on it is requesting access to a QuickBooks data file.
Note: APS and PracticeMaster do not integrate with QuickBooks. Instead, each of these programs
passes the requested data to QuickBooks via Tabs3 Billing. For more information on how
integration occurs with PracticeMaster, APS, TAS, GLS, and more, see the How Other Tabs3
Software Integrates with QuickBooks section (page 37).
Tip: For more information on Tabs3 and PracticeMaster Digital Certificates, visit Knowledge Base
Article R10905, “Authenticode Digital Certificate."
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Figure 2, QuickBooks Application Certificate

Figure 3, Access Confirmation
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Configuring Tabs3 Billing
In Tabs3 Billing, the following must be set up before integration can occur:
l

Customization

l

Clients

l

Transaction Codes

l

Sales Tax

Configuring Tabs3 Customization
Integration with QuickBooks must be turned on in the Tabs3 Billing Customization program before
other integration setup can occur.
▶ Configuring QuickBooks Integration in Tabs3 Billing Customization
1. Determine the location of the company file you want to integrate with. An example of a
QuickBooks Company file is: \\server1\Program Files\Intuit\QuickBooks Premier\Jensen.qbw.
(Note: We recommend using a UNC path to avoid potential problems with mapped drives
when all computers do not use the same mapped drive letter. When using a mapped drive,
the mapped drive is seen form the perspective of the workstation.) To locate your company
file, perform the following steps.
a. In QuickBooks, press F2 or Ctrl+1.
b. In the File Information section (Figure 4), the Location field shows the path of your
Company file. Write this down.
2. Close the Product Information window and then the QuickBooks company file.
3. In Tabs3 Billing, from the Utilities menu, select Customization (Figure 5).
4. On the Other Systems tab, select QBXML Format for the Type of Integration.
5. If you want the Client ID shown after the description in the QuickBooks General Journal
Entry’s Memo field, select the Append Client ID to QuickBooks General Journal Entry
Description check box.
6. In the Company File field, specify the location of the QuickBooks Company file from step 1.
The Browse button can be used to find the desired QuickBooks Company file.
7. Press Ctrl+S.
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Figure 4, QuickBooks Product Information

Figure 5, Tabs3 Billing Customization
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Configuring Tabs3 Billing Clients
When adding a new client in Tabs3 that will integrate with QuickBooks, you must first add a master
client record with no Work Description. This master client record is also referred to as a base client
file record. After saving the master client record, you can then add a matter (or job) for the client.
The master client record and matter for the client must have different Client IDs. For example,
“808726.00” represents a master client record that would be added first and “808726.01” represents a
job or matter added afterward. If this procedure is not followed, jobs may not be created in
QuickBooks, or they may be created improperly. If jobs are created improperly, further integration
for those jobs may not be possible. Keep in mind that adding a separate master client record only
applies for the first Matter for the client.
Note: If Tabs3 clients are not already set up in this manner, one or more clients in Tabs3 must be
renumbered before merging.
Tabs3 clients must have a Client ID, Primary Timekeeper, and Billing Category that match the
Account No, Rep, and Job Type for the customer in QuickBooks.
l

l

l

The Client ID field in Tabs3 Billing must match the Account No field in QuickBooks.
The Primary Reporting Timekeeper in Tabs3 Billing must match the Rep field in
QuickBooks.
The Billing Category field in Tabs3 Billing must match the Job Type field in the QuickBooks
Job record.

Tip: For a complete listing of field mappings between Tabs3 and QuickBooks, including
screenshots, see the Field Mapping Between Tabs3 and QuickBooks section of this Guide (page
43).
All clients are automatically set up to integrate with QuickBooks when Customization settings are
initially saved. However, you can individually change clients to not integrate with QuickBooks
(Figure 6).
▶ To disable integration for a client
1. In Tabs3 Billing, from the File menu, point to Open and select Client.
2. Select the desired Client ID.
3. From the Setup tab, clear the Integrate with QuickBooks check box.
4. Press Ctrl+S.
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Figure 6, Client Information, Setup tab

Configuring Tabs3 Billing Transaction Codes
In order for cost and payment transactions to integrate to QuickBooks, the transaction must be
saved with a transaction code (tcode) (Figure 7) and client configured to integrate with QuickBooks.
When configuring tcodes, keep the following in mind:
l

l

l

l

l

Fees do not integrate with QuickBooks, therefore the QuickBooks integration fields are not
available for tcodes with a Transaction Type of Fee.
Transaction codes with a Transaction Type of Expense or Advance create Bills and Bill journal
entries in QuickBooks. A default QuickBooks Debit Account can be specified for the tcode.
The QuickBooks Credit Account is always the Accounts Payable account. Therefore, the
QuickBooks Credit Acct field is not available.
Payment transaction codes create general journal entries in QuickBooks. A default
QuickBooks Debit Acct and QuickBooks Credit Acct can be specified for payment tcodes
(e.g., Debit Undeposited Funds and Credit Income Account).
The Tabs3 Billing Tcode Alpha Code field is used for integration instead of the Tcode number.
The Alpha Code is saved as a QuickBooks Class.
Transaction codes with the following Type do not integrate with QuickBooks:
l
Fee Tcodes
l

Type 4 - Description Only

l

Type 6 - Progress Fee
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▶ To configure cost and payment Tcodes in Tabs3 Billing
1. In QuickBooks, switch to multi-user mode.
2. In Tabs3 Billing, from the File menu, point to Open and then select Miscellaneous.
3. Click the Tcode tab.
a. In the Tcode field, specify a tcode that you want to integrate with QuickBooks.
b. In the Alpha Code field, enter a unique alpha code.
c. Select the Integrate with QuickBooks check box.
d. Specify a default QuickBooks Debit Acct.
e. Specify a default QuickBooks Credit Acct. This option is only available for payments.
f. Press Ctrl+S.
4. Repeat step 3 for all tcodes you want to integrate with QuickBooks.

Figure 7, Tabs3 Billing Tcode
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Configuring Tabs3 Billing for Assessing Sales Tax
Individual QuickBooks transactions do not contain sales tax. Therefore, in order for transactions that
are merged from QuickBooks to Tabs3 Billing to include sales tax, the client and transaction code in
Tabs3 Billing must be configured to assess sales tax.
To assess sales tax in Tabs3 Billing, the following must be configured:
l

Tabs3 Billing Customization (Figure 8)

l

Clients (Figure 9)

l

Transaction Codes (Figure 10)

Tip: Additional information regarding sales tax can be found in KB Article R10952, “Using Sales
Tax in Tabs3."
▶ Tabs3 Billing Customization
1. In Tabs3 Billing, from the Utilities menu, select Customization.
2. Click the Rates tab.
3. In the Sales Tax section, select the check boxes for each type of transaction you assess sales
tax for.
4. Enter up to 9 different sales tax rates.
5. Press the Esc key to close Customization.
6. Click Yes to save the changes.
▶ Tabs3 Billing Clients
1. In Tabs3 Billing, from the File menu, point to Open and select Client.
2. Select the client you want to charge sales tax.
3. Click the Billing Options tab.
4. In the Sales Tax section, select the sales tax to be assessed for expenses and advances.
5. Press Ctrl+S.
6. Repeat steps 2-5 for each client you want to charge sales tax.
Tip: Multiple clients can be configured at the same time using the Change Client Options
program.
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▶ Tabs3 Billing Transaction Codes
1. In Tabs3 Billing, from the File menu, point to Open and select Miscellaneous.
2. Click the Tcode tab.
3. Select the tcode that you want to assess sales tax for.
4. Select the Charge Sales Tax check box.
5. Press Ctrl+S.
6. Repeat steps 3-5 for each transaction code you want to assess sales tax for.

Figure 8, Customization, Rates tab

Figure 9, Client Information, Billing Options tab

Figure 10, Tcode
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Configuring QuickBooks
In QuickBooks, the following must be set up before integration can occur:
l

Customer

l

Class Tracking

l

Employee List

l

Sales Tax

Verifying the Customer Account No, Rep, and Job Type
QuickBooks customers must have an Account No, Rep, and Job Type that match the Client ID,
Primary Timekeeper, and Billing Category in Tabs3 Billing. To verify that existing customers have the
correct Client ID, open the Customer Center in QuickBooks and verify that the following fields match:
l

l

l

l

The Account No field in QuickBooks must match the Client ID field in Tabs3 Billing.
The Rep field in QuickBooks must match both the Name and Initials of the Primary
Reporting Timekeeper in Tabs3 Billing.
The Rep field in QuickBooks cannot be the same as a Vendor in QuickBooks.
In the QuickBooks Job record, the Job Type must match the Billing Category field in Tabs3
Billing.

Tip: For a complete listing of field mappings between Tabs3 and QuickBooks, including
screenshots, see the Field Mapping Between Tabs3 and QuickBooks section of this Guide (page
43).
When adding a new customer and job in QuickBooks, use the following guidelines:
l

l

When adding a new customer, you must specify a Sales Rep (i.e., a valid Tabs3 timekeeper)
and an Account No. (i.e., a new Tabs3 Client ID). Do not fill out any information on the Job
Info tab.
After saving the customer, you must then add a separate job for the customer. After adding
the job, you must fill out the information on the Job Info tab and specify an Account No.
(located on the Payment Settings tab) that is different from the account number for the
customer. On the Job Info tab, you must specify a Job Type (i.e., a valid Tabs3 Billing
Category Description).

Note: Customers and Jobs must have different Account Numbers. If this procedure is not followed
and the job has the same account number as the customer, the Job Type, Job Name, and Start Date
information will not pass from QuickBooks to Tabs3. Additionally, if the customer and job have
different addresses, contact names, phone numbers, etc., when the Merge QuickBooks Data with
Tabs3 program is run, the job information will be pulled into Tabs3 and will also be posted to
QuickBooks, thus overwriting the QuickBooks customer information.
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Setting Up Class Tracking
Cost transactions in Tabs3 Billing are assigned “tcodes”, which are equivalent to “classes” in
QuickBooks. Therefore, Class Tracking must be configured in QuickBooks if you want to merge
transactions from QuickBooks into Tabs3 Billing. Once Class Tracking is enabled, a “Class” (i.e.,
tcode) can be assigned to a bill or time tracking record, which is required for integration. For
integration, QuickBooks Classes must be set up as the Tabs3 Billing Tcode Alpha Code field instead
of the Tcode number.
▶ To configure Class Tracking in QuickBooks
1. In QuickBooks, switch to Single-user Mode.
2. In QuickBooks, from the Edit menu, select Preferences.
3. In the Preferences window, select Accounting from the list on the left (Figure 11).
4. Click the Company Preferences tab.
5. Select the Use class tracking for transactions check box.
6. Select Payroll & Employees from the list on the left (Figure 12).
7. When prompted to save, click Yes.
8. In the QuickBooks Payroll Features section, select Full Payroll.
9. For the Assign one class per option, select Earnings Item.
10. Click OK.

Configuring the Employee List to Display by First Name
If you want clients in Tabs3 Billing to integrate with QuickBooks, the Employee List must be
configured to display by First Name.
▶ To configure the Employee List to Display by First Name
1. In QuickBooks, switch to Single-user Mode.
2. In QuickBooks, from the Edit menu select Preferences.
3. Select Payroll & Employees from the list on the left (Figure 12).
4. Click the Company Preferences tab.
5. In the Display Employee List by section, select First Name.
6. Click OK.
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Figure 11, QuickBooks Accounting

Figure 12, QuickBooks Payroll & Employees

Configuring QuickBooks for Assessing Sales Tax
Since sales tax is not assigned to individual Bills in QuickBooks, Tabs3 Billing sales tax information
cannot be sent to QuickBooks. However, if the client is set up for sales tax in QuickBooks, all
transactions for that client are considered taxable once they are placed on a QuickBooks invoice or
statement. This is true regardless of whether the Tabs3 Billing transaction contained sales tax or not.
Therefore, the following must be configured in QuickBooks in order to assess sales tax in
QuickBooks:
l

Sales Tax Item (Figure 13)

l

Customer (Figure 14)

▶ Sales Tax Item
1. In QuickBooks, switch to Single-user Mode.
2. In QuickBooks, from the Edit menu, select Preferences.
3. From the list on the left, select Sales Tax.
4. Click the Company Preferences tab.
5. For the Do You Charge Sales Tax option, select Yes.
6. In the Set Up Sales Tax Item section, configure the necessary Sales Tax Items.
7. Specify any other sales tax preferences as desired.
8. Click OK.
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▶ Customer
1. From the Customers menu, select Customer Center.
2. Double-click the customer you want to assess sales tax for.
3. Click the Sales Tax Settings tab.
4. Specify a Tax Code and Tax Item.
5. If a customer is sometimes exempt from sales tax, enter the customer’s tax exemption ID in
the Resale Number field.
6. Click OK.
7. Repeat steps 2-6 for all customers you want to assess sales tax for.

Figure 13, QuickBooks Sales Tax

Figure 14, QuickBooks Customer

Note: When QuickBooks is configured to calculate sales tax, a Sales Tax Payable account is
created in QuickBooks. If you select this account for an expense or advance transaction code in
Tabs3 Billing, the error message “A/P detail line must have a vendor” or “Sales Tax detail line must
have vendor” will be displayed. To avoid this message, do not select the Sales Tax Payable account
when setting up transaction codes to integrate with QuickBooks.
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Getting Started
Once Tabs3 Billing and QuickBooks have been configured for integration, you must complete an
initial integration.

Implementation Scenarios
The steps for your initial integration depend on whether there is pre-existing data in Tabs3 Billing,
QuickBooks, or both systems. If data exists in both systems, you must complete all steps prior
to running the Send Tabs3 Data to QuickBooks and Merge QuickBooks Data with Tabs3
programs.

Posting an Existing Tabs3 Client Database to QuickBooks
If you have been using Tabs3, and you want your current client database to be posted to
QuickBooks, you can use the following procedures:
▶ To send Tabs3 data to QuickBooks
1. Make sure each Tabs3 client matter has a base client. The client matter and base client must
have the same name with different Client IDs. You may need to use the Renumber Clients
utility to accomplish this.
2. Although Tabs3 will add timekeepers to QuickBooks on the fly as required, you may want to
define all Tabs3 timekeepers as employees in QuickBooks in order to avoid potential issues
with long names. If you add timekeepers in Tabs3, be sure to also designate them as sales
reps in QuickBooks.
3. Run a Data File Integrity Check. Proceed only if there are no errors.
4. Make a backup of the Tabs3 data files and the QuickBooks Company File.
5. If data does not exist in QuickBooks, run the Send Tabs3 Data to QuickBooks program.

Bringing over an Existing Customer:Job Database from
QuickBooks
If you have been using QuickBooks, and you want to bring over your current customer database into
Tabs3, you can use the following procedures:
▶ To merge QuickBooks data with Tabs3
1. Make sure each employee in QuickBooks has a corresponding timekeeper in Tabs3. Also
make sure these employees are configured as sales reps in QuickBooks.
2. Make sure each Tabs3 Category Description has a corresponding valid Job Type.
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3. Make sure each customer has a job. Each customer and job in QuickBooks needs a unique
account number that is a valid Client ID in Tabs3. Customers and jobs without a valid account
number will not be passed to Tabs3.
4. Make sure each customer and job in QuickBooks is assigned a Sales Rep.
5. Make sure each customer and job in QuickBooks is assigned a valid Job Type.
6. Run a Data File Integrity Check. Proceed only if there are no errors.
7. Make a backup of the Tabs3 data files and the QuickBooks Company File.
8. If data does not exist in Tabs3, run the Merge QuickBooks Data with Tabs3 program to merge
the QuickBooks information into Tabs3.

When Data Exists in both Tabs3 and QuickBooks
If you have been using both Tabs3 and QuickBooks, and you now want to integrate the two systems,
follow the steps for both scenarios above before running the Send Tabs3 Data to QuickBooks
and Merge QuickBooks with Tabs3 programs.

Disabling Integration after Clients and Costs have Merged
from QuickBooks to Tabs3
If, after having successfully brought over all clients and costs from QuickBooks, you no longer want
to integrate with QuickBooks, simply disable the QuickBooks integration setting in Tabs3
Customization using the following procedures:
▶ To disable QuickBooks integration
1. In Tabs3 Billing, from the Utilities menu, select Customization.
2. On the Other Systems tab, in the QuickBooks Integration section, select a Type of
Integration of None.
3. Press Ctrl+S.

Initial Integration
Menu: Maintenance | Integration | QuickBooks Integration
Home: All Actions | Integration | QuickBooks Integration

Once Tabs3 and QuickBooks have been set up to integrate, you must merge preexisting data from
one program to the other. This is accomplished via QuickBooks Integration.
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Type of Integration
The Type of Integration field provides two options: Merge QuickBooks Data with Tabs3 (Figure
15) and Send Tabs3 Data to QuickBooks.
Merge QuickBooks Data with
Tabs3

The Merge QuickBooks Data with Tabs3 option is used
to retrieve new QuickBooks information and post it to
Tabs3.

Send Tabs3 Data to QuickBooks

The Send Tabs3 Data to QuickBooks option is used to
send Tabs3 client and cost records to QuickBooks. This
program will typically be used only once since integration
from Tabs3 to QuickBooks is automatic. This program is
provided specifically for firms who have been using Tabs3
and implement QuickBooks after the Tabs3 data files have
already been established.

Tabs3 File
The Tabs3 File field provides the option to merge/send All clients and costs, Clients only, or Costs
only.
It is recommended that the Send Tabs3 Data to QuickBooks program is run for just clients before
costs are sent to QuickBooks. This is because Tabs3 allows different Client IDs to have the same
name, however QuickBooks doesn’t allow two Customers to have the same name. Furthermore,
QuickBooks doesn’t allow a Customer to have the same name as a QuickBooks Vendor,
Employee, or name on the Other Names List. If costs exist in Tabs3 for both Clients, only
transactions for one of the clients will be sent to QuickBooks because only one client will get added
to QuickBooks. Running the Send Tabs3 Data to QuickBooks program for only clients first will
allow you to find out which clients have duplicate names before sending costs to QuickBooks.

Merge Count
The merge count section provides the number of records for clients and for costs that were added,
changed, or were rejected due to errors.
Count

The Count column indicates the total number of records
that were modified.

Add

The Add column indicates the number of records that
were added.

Change

The Change column indicates the number of records that
were changed.
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Error

The Error column indicates the number of errors that were
rejected due to errors.
Tip: Errors occurring during the Merge QuickBooks
Data with Tabs3 and Send Tabs3 Data to QuickBooks
processes will be stored in a file called STQBERR.LOG.

The OK button can be used to begin the merge process. This program will verify the information
from QuickBooks before merging it with the main Tabs3 data files. During the merge process, various
counts are displayed indicating how far along the process is. Upon completion of the merge process,
the message “Task Complete” will be displayed.
The Cancel button will close the window without merging data. Once the merge process has started,
it cannot be aborted.

Figure 15, QuickBooks Integration window in Tabs3

How Tabs3 Integrates with QuickBooks
Integration from Tabs3 Billing to QuickBooks is automatic. Whenever a client or cost is added to
Tabs3 Billing, a corresponding customer or bill is automatically added to QuickBooks (provided the
client or tcode is configured to integrate with QuickBooks). Journal entries are automatically created
in QuickBooks for costs and payments in Tabs3 Billing.

How Clients, Costs, and Payments Integrate
The following discusses how clients, costs, and payments are integrated from Tabs3 Billing to
QuickBooks.
For a complete listing of field mappings between Tabs3 and QuickBooks, including screenshots, see
the Field Mapping Between Tabs3 and QuickBooks section of this Guide (page 43).
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See the Best Practices section of the Guide (page 36) for recommendations on which actions should
be performed in Tabs3 Billing, QuickBooks, or both.

Clients
In order to integrate clients with QuickBooks, the Integrate with QuickBooks check box must be
selected on the Setup tab in the Client file. When clients are added, changed, or deleted, the
following will occur:
l

l

l

Information is posted to QuickBooks automatically whenever a client is added in Tabs3 or an
integrated field is changed in Tabs3 (with a few field exceptions as noted in the Field
Mapping Between Tabs3 and QuickBooks section of this Guide [page 43]).
Deleting a client in either system will not delete the client in the other system.
Deleting a client in Tabs3 will delete all of the fees and costs for that client in Tabs3.
However, the corresponding QuickBooks customer and its Bill records will not be deleted.

Notes on Client Integration
l

l

l

l

l

l

l

l

If no Work Description is specified in Tabs3, a job is not created in QuickBooks. Therefore no
information is posted to the Job Type, Job Start Date, and Job End Date fields in QuickBooks
(even though there may be information in these Tabs3 fields).
When adding a client matter in Tabs3, in order for it to be passed to QuickBooks as a job, the
client must have the exact same Client Name contact as the main client.
There are several fields that could integrate with Tabs3 but are not supported by Intuit’s
QBXML (such as the QuickBooks Mobile Phone field).
Changes made to the Date Opened, Date Closed, or Primary Timekeeper fields in Tabs3 will
not be passed to QuickBooks.
Changing a client’s name in Tabs3 will create a new customer in QuickBooks. The
corresponding old QuickBooks customer is not affected. You must change the customer’s
name in QuickBooks before changing the client’s name in Tabs3.
Client in Tabs3 with the same client name and work description as an existing customer in
QuickBooks will not be added to QuickBooks.
Adding a client in Tabs3 with the same client name as a QuickBooks Sales Rep will generate
the following error message and the customer will not be added to QuickBooks: “The name
XXXXXX of the list element is already in use.” Consider changing the client contact’s name in
Tabs3 slightly (e.g., by adding or deleting a middle initial, etc., using the Rename Contact
program).
Tabs3 will add a record to the QuickBooks Sales Rep and Job Type lookup lists if the
corresponding information specified in Tabs3 does not already exist in QuickBooks.
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l

l

l

l

l

l

l

l

l

Although allowed in Tabs3, duplicate values in certain fields will cause unpredictable results.
Make sure you do not have duplicate values for the following fields in Tabs3: Timekeeper
Name, Timekeeper Initials, and Category Description.
Secure client information in Tabs3 is passed to QuickBooks (provided the Tabs3 user has
adequate rights). QuickBooks does not have secure clients, so secure clients will move to
QuickBooks and be viewable.
The Tabs3 Data File Integrity Check program will generate errors for clients with no name and
employees with no initials. Addressing these issues helps eliminate rejected records and
duplicate employees.
Clients marked as Inactive in Tabs3 will move over to QuickBooks, but are not marked as
Inactive in QuickBooks. An Inactive client’s payments, costs and fees will also move over
from Tabs3 to QuickBooks.
Renumbering a client in Tabs3 will renumber the Account Number in QuickBooks.
The Change Key Type program will write all clients and matters to QuickBooks at one time for
clients that do not already exist in QuickBooks.
QuickBooks does not allow colons in their Name fields. When you attempt to save a record
containing a colon in the Client Name, Timekeeper Name, or Category Description files, the
message “Invalid QuickBooks Name. Colon not allowed.” will be displayed.
Renumbering a category forces Tabs3 to write all clients and matters to QuickBooks at one
time for clients assigned to that category that do not already exist in QuickBooks. Changes
are not made to the QuickBooks Job Type because it is the category description that links the
records, not the category number.
Renumbering a timekeeper forces Tabs3 to write all clients and matters to QuickBooks at one
time for clients assigned to that timekeeper that do not already exist in QuickBooks. Changes
are not made to the QuickBooks Sales Rep because it is the timekeeper’s initials and name
that link the records, not the timekeeper number.

Costs
When costs are added, changed, or deleted, the following will occur:
l

l

l

l

In the cost file, adds are supported both ways.
Changes in Tabs3 cost records are not passed to QuickBooks. However, changes to Bills in
QuickBooks are passed to Tabs3.
Deletions of cost records in either program will not delete the corresponding cost in the
other program.
Deleting a client in Tabs3 will delete all costs for the client in Tabs3, but will not delete the
Customer, or the corresponding Bills for the Customer, in QuickBooks. The Bill in QuickBooks
must also be deleted, voided, or placed on an Invoice or Statement. Otherwise, the cost will
be added back into Tabs3 when the Merge QuickBooks Data with Tabs3 program is run.
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Tip: In order to integrate costs with QuickBooks, the Integrate with QuickBooks check box must
be selected on the Setup tab in the Client file and in the Transaction Code file for the specified
cost transaction code.
Additionally, after adding a cost transaction to Tabs3, detail journal entries are posted directly into
QuickBooks. The QuickBooks DB Acct field in the Cost file determines the QuickBooks account
which the Debit entry is posted to. A Default debit account can be specified for each cost
transaction code. The credit account is always the QuickBooks Accounts Payable account.
In order to integrate costs with QuickBooks, Class Tracking must be enabled in QuickBooks. This is
required to work with Tabs3 transaction codes.

Cost Credits
Entering a cost credit in Tabs3 creates a Credit Memo in QuickBooks.

Notes on Cost Integration
l

l

l

l

l

l

l

If the client you are creating the cost for is configured to integrate with QuickBooks (i.e., the
Integrate with QuickBooks check box is selected on the Setup tab in the Client file), the
client must exist in QuickBooks. Otherwise an error will be displayed while the cost
transaction is being saved indicating an invalid reference or argument was encountered. No
information will be passed to QuickBooks in this situation.
Rich Text Format attributes (RTF - bold, italics, underline) are not supported by QuickBooks;
therefore these attributes are stripped before the description is passed to QuickBooks.
When cost transactions are passed from Tabs3 to QuickBooks, the Alpha Code associated
with the specified tcode is added to the QB Class List (if it is not already present).
When cost transactions are passed from Tabs3 to QuickBooks, the Bill Due in QuickBooks is
ten days after the Date in Tabs3 Billing.
Tabs3 costs with an amount of “0.00” are passed to QuickBooks as a Paid Bill.
All billable Tabs3 costs are passed to QuickBooks as billable (i.e., Bill Code = “0” Billable/Printable, “3” = Billable/Non-Printable, or “4” - Billable/Always Print). Non-Billable
Tabs3 costs (i.e., “2” - Non-Billable/Printable, “3” - Billable/Non-Printable) are passed to
QuickBooks as non-billable.
QuickBooks does not add sales tax to an entry until it is put on a Sales Form, therefore Tabs3
cannot send sales tax information to QuickBooks

Payment Entry
When a payment is entered into Tabs3, General Journal Entries are created in QuickBooks; however,
the actual payment is not integrated. For this reason, it is recommended to only integrate payment
transaction codes with QuickBooks if the actual payments will not be entered directly into
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QuickBooks. If you enter a payment in QuickBooks and create the QuickBooks General Journal
Entries for Tabs3 payments, this would result in double posting. Saving a payment in Tabs3 Billing
opens the General Journal Entry Window.

General Journal Entry Window
Payment integration is based on a double-entry accounting system. For each Tabs3 payment
transaction that integrates with QuickBooks, you will need to post a minimum of one debit and one
credit via the QuickBooks General Journal Entry window (Figure 16). Compound journal entries are
allowed and there is no limit to the number of debits and credits that can be posted for a single
payment transaction. Each debit and credit for the transaction is entered in the Journal Entry portion
of the window. Default QuickBooks debit and credit accounts can be specified for each cost and
payment transaction code. The Save Record button is then used to save the debit or credit to the
lower portion of the window. Once all debits and credits for the transaction have been saved, the
Save All button can be used to save the journal entry. Equal debits and credits must be posted
before the journal entry can be saved. (Note: You can save journal entries for a portion of the
transaction as long as the debits and credits are equal; however, this is typically not recommended
since Tabs3 will not be able to make adjusting entries in the future if necessary.)
The Total and Remaining amounts are
shown at the top of the window to
assist with posting the journal entry.
The Total figure represents the full
amount of the Tabs3 payment
transaction. This figure does not
change. The figures in the Remaining
column, including the Balance figure,
are updated each time a debit or credit
is saved or deleted (and also when the
Apply Balance button is used). When
equal debits and credits for the full
payment transaction amount have
been posted, the Remaining Debit,
Remaining Credit and Balance figures
will all be set to 0.00 and you can use
the Save All button to save the journal
entry to QuickBooks.

Figure 16, QuickBooks General Journal Entry Window

Payment Adjustments
If you are integrating with QuickBooks and a QuickBooks journal entry was posted for the original
payment, an adjusting QuickBooks journal entry is created automatically when a payment is reversed
or refunded, provided both the transaction code and the client are configured to integrate with
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QuickBooks. The process is performed without the QuickBooks General Journal Entry window being
displayed. The date of the adjusting journal entry is the date of the original payment. Adjustments in
QuickBooks are made regardless of whether the period in QuickBooks has been closed.

Payment Reversal
A reversing journal entry is created for the QuickBooks journal entry associated with the payment.
For example, if the journal entry for the original payment was Debit Cash $300 and Credit Fee Income
$300, the reversing entry will be Credit Cash $300 and Debit Fee Income $300.

Payment Refund
When a partial payment is adjusted, an adjusting journal entry is created for the QuickBooks journal
entry associated with the payment. For example, if the journal entry for the original payment was
Debit Cash $300 and Credit Fee Income $300, and $50 was refunded, the adjusting entry will be Credit
Cash $50 and Debit Fee Income $50.
Note: In the event a payment entry had multiple debits or credits, then the amounts for the new
journal entry is proportionately adjusted and any left over amount due to rounding will be
included with the last debit and/or credit account.

What Does Not Integrate
The following Tabs3 Billing items do not integrate with QuickBooks.

Fees
Fees entered in Tabs3, PracticeMaster, Tabs3 Connect, or Tabs3 Remote do not integrate with
QuickBooks.

Archived Transactions
When a statement is updated in Tabs3 Billing, transactions are changed from work-in-process to
archived. The archived transactions do not integrate with QuickBooks; they are neither added nor
removed. Only work-in-process transactions will integrate with QuickBooks, either upon saving the
transaction, or when running the Send Data to QuickBooks program.

Accounts Receivable Balance
Since Tabs3 Billing does not integrate fees or archived transactions, and payments are sent to
QuickBooks as general journal entries, an accounts receivable balance cannot be integrated.

Client Funds
Client Funds do not integrate with QuickBooks.
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Progress Billing Codes
Progress Billing transaction codes do not integrate with QuickBooks.

Write Offs
Although payment reversals and refunds integrate with QuickBooks, write offs do not.

How QuickBooks Integrates with Tabs3
Billing
Integration from QuickBooks to Tabs3 Billing is performed on demand. Running the Merge
QuickBooks Data program in Tabs3 Billing transfers all new or changed clients and bill (cost) entries
in QuickBooks to Tabs3 Billing.

How Clients and Costs Integrate
The following discusses how clients and costs are integrated from QuickBooks to Tabs3 Billing. For a
complete listing of field mappings between Tabs3 and QuickBooks, including screenshots, see the
Field Mapping Between Tabs3 and QuickBooks section of this Guide (page 43).
See the Best Practices section of the Guide (page 36) for recommendations on which actions should
be performed in Tabs3 Billing, QuickBooks, or both.

Clients
When clients are added, changed, or deleted, the following will occur:
l

l

l

l

Whenever a customer or job is added in QuickBooks or an integrated client field is changed
in QuickBooks, the information will be posted to Tabs3 the next time the Merge QuickBooks
Data with Tabs3 program is run.
Deleting a customer|client in either system will not delete the client|customer in the other
system.
Deleting a customer or job in QuickBooks does not delete the client in Tabs3. You must
manually delete the client in Tabs3.
Clients marked as Inactive in QuickBooks will not move over to Tabs3; however, costs and
fees will move over to Tabs3 from an Inactive client in QuickBooks.
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Costs
When costs are added, changed, or deleted, the following will occur:
l

l

l

l

In the cost file, adds are supported both ways.
Changes in Tabs3 cost records are not passed to QuickBooks. However, changes to Bills in
QuickBooks are passed to Tabs3.
Deletions of cost records in either program will not delete the corresponding cost in the
other program.
Deleting a client in Tabs3 will delete all costs for the client in Tabs3, but will not delete the
Customer, or the corresponding Bills for the Customer, in QuickBooks. The Bill in QuickBooks
must also be deleted, voided or placed on an Invoice or Statement. Otherwise, the cost will
be added back into Tabs3 when the Merge QuickBooks Data with Tabs3 program is run.

Credit Memos
Credit Memos are integrated with Tabs3 as follows:
l

l

Credit memos are passed to Tabs3 as cost credit transactions if the “Qty” field on the credit
memo is blank.
In QuickBooks, you can mark a Bill as a Credit. This type of credit transaction does not get
passed to Tabs3.

Note: Credit memos are typically not used when integrating with Tabs3 because accounts receivable
is maintained in Tabs3.

Notes on Cost Integration
l

l

l

l

l

QuickBooks classifies Bills, Checks, and Credit Card Transactions as Expenses or Items. Only
Expenses are passed to Tabs3.
There are two Memo fields in QuickBooks. The memo field directly under the Bill/Credit Card
area is not passed to Tabs3.
Although QuickBooks does not require a customer/job to be entered for Bills, Tabs3 requires
it. If a Bill is entered into QuickBooks without a customer/job, no information will be passed
to Tabs3 when the Merge QuickBooks Data with Tabs3 program is run.
Although QuickBooks does not require a Class (tcode) to be entered for Bills, Tabs3 requires
it. If a Bill is entered into QuickBooks without a class, no information will be passed to Tabs3
when the Merge QuickBooks Data with Tabs3 program is run.
Bills, checks, and credit card transactions created in QuickBooks are passed to Tabs3 using
the Tabs3 client’s primary timekeeper for the Timekeeper field.

l

The QuickBooks vendor is passed to the QuickBooks Vendor field in Tabs3.

l

The QuickBooks account is passed to the QuickBooks Debit Account Field in Tabs3.
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l

l

l

Bills that are tagged as non-billable in QuickBooks are passed to Tabs3 as billable.
If the Bill Received check box is cleared, the Bill is considered an “Item receipt Only”. These
transactions do not get passed to Tabs3.
Cost transactions merged into Tabs3 will have sales tax if the Client in Tabs3 is set up to have
sales tax on the Billing Options tab of the Client file and the Charge Sales Tax check box is
selected for the cost transaction code in the Transaction Code file.

Reporting Data from QuickBooks
There are several reports in Tabs3 Billing that can be run to show transactions that were merged from
QuickBooks to Tabs3 Billing. Additionally, you can run a report to see which tcodes have been set up
to integrate with QuickBooks.

Detail Work-In-Process Report
Menu: Reports | Work-In-Process | Detail Work-In-Process Report
Home: All Actions | Reports | Work-In-Process Reports | Detail Work-In-Process Report

The Detail Work-In-Process Report can be set up to show which transactions came from
QuickBooks. The following option must be selected in order for QuickBooks information to be
displayed on the report:
l

On the Format tab, you must select the Source check box. This option specifies that the Src
column be displayed on the report.

When printing the Detail Work-In-Process Report with this option, any transactions that came from
QuickBooks will be indicated by a “Q” in the Src column.

Task Code Billing Report
Menu: Reports | Transactions | Task Code Billing Report
Home: All Actions | Reports | Transaction Report | Task Code Billing Report

The Task Code Billing Report can be set up to show which task based billing transactions came from
QuickBooks. The following two options must be selected in order for QuickBooks information to be
displayed on the report:
l

On the Options tab in the Source section, QuickBooks must be selected. This option
specifies that transactions originating in QuickBooks should be included on the report.
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l

On the Format tab, you must select the Source check box. This option specifies that the Src
column be displayed on the report.

When printing the Task Code Billing Report with these options, any transactions that came from
QuickBooks will be indicated by a “Q” in the Src column.

Transaction Code List
Menu: Reports | Miscellaneous | Transaction Code List
Home: All Actions | Reports | File Lists | Transaction Code List

When printing the Transaction Code List, each transaction code that integrates with QuickBooks will
be indicated by a “Y” in the QB column.

Transaction File List
Menu: Reports | Transactions | Transaction File List
Home: All Actions | Reports | Transaction Report | Transaction File List

The Transaction File List can be set up to show which transactions came from QuickBooks. The
following two options must be selected in order for QuickBooks information to be displayed on the
report:
l

l

On the Options tab in the Source section, QuickBooks must be selected. This option
specifies that transactions originating in QuickBooks should be included on the report.
On the Format tab, you must select the Source check box. This option specifies that the Src
column be displayed on the report.

When printing the Transaction File List with these options, any transactions that came from
QuickBooks will be indicated by a “Q” in the Src column.

Verification Lists
When printing a Cost Verification List, any cost transactions that came from QuickBooks will be
indicated by a “Q” in the Src column.
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Best Practices
As a result of the different ways that the QuickBooks and Tabs3 data files use key fields, there is a
difference in how changes and deletions are handled. Changes made in QuickBooks are brought
over to Tabs3; however, changes made in Tabs3 are not posted to QuickBooks. Conversely, deletions
made in QuickBooks are not brought over to Tabs3.
The following table includes the recommended system to use for the various integrated tasks.
Function

Recommended System

Why

Adding or Changing Clients

Either System

Integration works both ways.

Deleting Clients

Required in Both Systems

Deleting a client in Tabs3 Billing will delete
the client as well as all transactions in Tabs3,
but neither the Customer, nor Bills for the
Customer will be deleted in QuickBooks.
Deleting a Customer in QuickBooks will not
remove any transactions from Tabs3 and will
not delete the Client.

Adding Costs

Either System

Integration works both ways.

Changing Costs

QuickBooks

Changing a transaction in Tabs3 does not
change the transaction in QuickBooks.

Deleting Costs

Required in Both Systems

Deleting a cost transaction in Tabs3 will not
delete the corresponding Bill record from
QuickBooks.
Deleting a transaction in QuickBooks does
not delete the corresponding transaction in
Tabs3.

Deleting Payments

Tabs3

Deleting, reversing, or refunding a payment
in Tabs3 will automatically make reversing
Journal Entries in QuickBooks.
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How Other Tabs3 Software Integrates
with QuickBooks
The following provides information on how other Tabs3 Software integrates with QuickBooks. It is
important to understand that programs other than Tabs3 Billing do not integrate with QuickBooks.
Instead, each of these programs passes the requested data to QuickBooks on behalf of Tabs3 Billing.
Clients and Transaction Codes must be set up in Tabs3 Billing to integrate with QuickBooks in order
for other Tabs3 software to pass data from QuickBooks via Tabs3 Billing.

PracticeMaster
QuickBooks integration is not available with PracticeMaster only. However, QuickBooks will
integrate with PracticeMaster when Tabs3 is installed. When Tabs3 is installed, clients and costs
entered in PracticeMaster will integrate with QuickBooks.

Tabs3 Trust Accounting Software
Tabs3 Trust Accounting Software (TAS) integrates as follows:
l

Payments to Firm from TAS do not integrate with QuickBooks. However, as a work-around,
opening a saved “Payment to Firm” from TAS in Tabs3 Billing and saving the record again will
then integrate the payment record with QuickBooks.

l

Clients added in TAS will integrate to QuickBooks via Tabs3.

l

Client information changed in TAS will integrate to QuickBooks via Tabs3.

Tabs3 Accounts Payable Software
Cost transactions for Tabs3 Billing are optionally created through Accounts Payable Software (APS)
when adding an invoice or manual check via the Cost Entry window. These cost transactions will
integrate with QuickBooks via Tabs3.

Tabs3 General Ledger Software
Tabs3 General Ledger Software (GLS) integrates as follows:
l

l

Tabs3 Billing cannot be configured to integrate with QuickBooks and GLS at the same time.
If APS is configured to integrate with both Tabs3 Billing and GLS, then saving an invoice can
do the following:
l
Optionally create a cost in Tabs3 Billing, which will then create a QuickBooks Bill and
QuickBooks journal entries.
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l

Optionally create GLS journal entries.

Tabs3 Connect
Cost transactions added via Tabs3 Connect do not integrate directly with QuickBooks. Instead, the
Send Tabs3 Data to QuickBooks utility can be used to periodically send these costs to QuickBooks.

Cost Recovery Software
Cost transactions merged into Tabs3 Billing using the “Merge Data Capture Transactions” program
will integrate to QuickBooks with a vendor of STI-Vendor. The debit account will be the account
specified in the Transaction Code file. If no debit account is configured for the transaction code, the
STI-Expense account will be used. QuickBooks must be open when the “Merge Data Capture
Transactions” program is run.

Tabs3 Remote
Cost transactions merged into Tabs3 Billing using the “Merge Tabs3 Remote Data” program will
integrate with QuickBooks as follows.
l

l

l

When entering costs in Tabs3 Remote, you can specify a QuickBooks Vendor. Any vendor
can be entered (there is no drop-down list to select one). If you specify a vendor that does
not already exist in QuickBooks, that vendor will be added to QuickBooks. If no vendor is
specified, the STI-Vendor will be the QuickBooks vendor when the information is merged.
Tabs3 Remote does not have a QuickBooks Debit Account field. Therefore, the debit
account will be the account specified in the Transaction Code file. If no debit account is
configured for the transaction code, the STI-Expense account will be used.
QuickBooks must be open when the Merge Tabs3 Remote Data program is run.

Note: Remote validation files do NOT contain QuickBooks information. Integration occurs
through Merge Tabs3 Remote Data.
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Technical Considerations
When integrating Tabs3 with QuickBooks, keep the following in mind.

Renaming Contacts
Renaming the client contact name in Tabs3 Billing does not change the name of the existing
QuickBooks customer. Instead, a new customer is added to QuickBooks.

Undo Updated Statement(s)
When running the Undo Single Updated Statements or Undo Multiple Updated Statements programs
in Tabs3 Billing, integration with QuickBooks occurs as follows:
Original statement was updated
when configured for integration

Cost transactions are never deleted from QuickBooks.
Therefore, cost transactions do NOT integrate to
QuickBooks a second time when the statement is undone.
Journal Entries are not affected by Undo Updated
Statements in Tabs3 Billing.
Credits do NOT sync to QuickBooks a second time when
the statement is undone.

Original statement was updated
prior to turning on integration

If the client is set up to integrate with QuickBooks, and the
client exists in QuickBooks, integration with QuickBooks
occurs as follows:
Transactions will integrate to QuickBooks if the
transaction code assigned to the transaction is currently
set up to integrate with QuickBooks. Cost transactions will
be assigned to STI-Vendor.
Journal entries will be created for cost transactions. The
QuickBooks debit account will be the account specified
for the transaction code. If the transaction code does not
have a default debit account, the STI-Expense account will
be the debit.
Payment transactions will NOT create new Journal Entries
in QuickBooks.
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Backing Up Data
Tabs3 and QuickBooks backups must be made at the same time. If you restore a backup of one
system and not the other, your data may become mismatched.

QuickBooks Remote Data Sharing (RDS)
In order for Tabs3 to integrate with QuickBooks, QuickBooks must be installed on each computer on
which Tabs3 is also used. Alternatively, Tabs3 and PracticeMaster users can pass information to the
QuickBooks data files without having QuickBooks installed by using the QuickBooks Remote Data
Sharing (RDS) software.
Tip: For information on installation, configuration, and troubleshooting for QuickBooks RDS, see
Knowledge Base Article R10884, “QuickBooks Remote Data Sharing."

Troubleshooting QuickBooks Integration
When integrating with QuickBooks, various messages can be displayed. Knowledge Base Article
R10883, “Troubleshooting QuickBooks Integration,” includes an alphabetical list of these messages
and the steps necessary to troubleshoot.
Tip: If you are looking for a specific message in the article, press Ctrl+F and search for a portion of
the message.
Tip: Errors occurring during the Merge QuickBooks Data with Tabs3 and Send Tabs3 Data to
QuickBooks processes will be stored in a file called STQBERR.LOG.
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Resources
Additional information on the features included in this guide is available via Tabs3’s built-in help
files and the Tabs3 and PracticeMaster Knowledge Base.

Built-in Help
Help is installed with the software and is easily accessed by pressing F1, by clicking the
button, or
by selecting the Help | Help Topics menu option. Help includes detailed information regarding
specific programs. Clicking the
button opens the relevant Help topic for the window you are
currently using. Many times, reading the appropriate Help topic may be the fastest way to find your
answer.

Knowledge Base
Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can also access our
Knowledge Base while in the software by selecting Help | Internet Resources | Knowledge Base.
l

l

l

l

l

l

R11591 - “QuickBooks FAQ,” contains frequently asked questions about the integration
between Tabs3 and QuickBooks.
R10884 - “QuickBooks Remote Data Sharing,” includes installation, configuration, and
troubleshooting for QuickBooks RDS.
R10883 - “Troubleshooting QuickBooks Integration,” includes messages that may be
displayed when using QuickBooks. The messages are listed in alphabetical order.
R11752 - “Third Party Integration Requirements,” provides an overview of the specific
versions and releases of third party applications currently tested and supported that integrate
with or convert to Tabs3 and PracticeMaster software.
R10905 - “Authenticode Digital Certificate,” provides information on the benefits of digital
certificates and how they work.
R11594 - “Overview of QuickBooks Integration”

All Knowledge Base Articles are available on our Web site at:

support.Tabs3.com
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Field Mapping Between Tabs3 and
QuickBooks
The following screenshots and tables depict the field mappings for the Client and Cost files when
configured for integration.

Client File Screenshots
The following screenshots depict the comparable field names between Tabs3 Billing and
QuickBooks.

Figure 17, Tabs3 Client Name, Address, Phone, and Email
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Figure 18, QuickBooks Customer, Phone, Email, and Address

Figure 19, Tabs3 Work Description

Figure 20, QuickBooks Job Name

Figure 21, Tabs3 Client ID

Figure 22, QuickBooks Account No.
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Figure 23, Tabs3 Primary Timekeeper

Figure 24, QuickBooks Rep

Figure 25, Tabs3 Date Opened and Date Closed

Figure 26, QuickBooks Start Date and End Date

Figure 27, Tabs3 Billing Category

Figure 28, QuickBooks Job Type
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Fields in the Client File
Note: You can add or change clients/customers in either system. However, deleting a
Client/Customer in either system will not delete it in the other system.
The following table contains a complete listing of integrated fields in the client/customer file. If a
field is not listed, that field does not integrate between programs.

Tabs3
Name (Client) (50)
Figure 17

QuickBooks

Notes

Customer (Name)(41) Changing the Tabs3 client name does not change the
Figure 18
name of the existing QuickBooks customer. Instead, a
new customer is added to QuickBooks.
Changing the QuickBooks customer name does not
change the name of an existing Tabs3 client. Instead, an
error will be produced when you attempt to merge.
Clients with a blank name are not allowed in QuickBooks.
Client names can include any keyboardable character
except for a colon. QuickBooks does not allow the use of
colons in the Customer Name field.

Desc (Work Description)
(50)
Figure 19

Job Name (41)
Figure 20

Addr1 (Selected Address,
Line 1) (35)
Figure 17

Address (Line 2) (41)
Figure 18

Only integrates for Jobs.
If a Work Description is not specified in Tabs3, no job is
created in QuickBooks.
For its Address (Line 1) field, QuickBooks uses Tabs3’s
Client Name field.
Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.
Deleting an address line in either system will not delete
it in the other system.

Addr2 (Selected Address,
Line 2) (35)

Address (Line 3) (41)

Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.
Deleting an address line in either system will not delete
it in the other system.

City (Selected Address)
(20)
Figure 17

City (31)
Figure 18

Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.
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Tabs3
State (Selected Address)
(3)
Figure 17

QuickBooks
State/Province (21)
Figure 18

Notes
Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.

Zip (Selected Address) (10) Zip/Postal Code (13)
Figure 17
Figure 18

Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.

Country (Selected
Address) (20)

Country/Region (31)

Phone 1 (Business) (31)
Figure 17

Phone (21)
Figure 18

Phone 2 (Home) (31)
Figure 17

Alt. Phone (21)
Figure 18

Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.
Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.
Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.

Phone 3 (Business Fax) (31) FAX (21)

Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.

Email_Address (100)
Figure 17

Email (99)
Figure 18

Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.

Contact (Name) (50)
Figure 17

Contact (41)
Figure 18

Primary Timekeeper
Initials (3) and Primary
Timekeeper Name (35)
Figure 23

Rep (5) and
QuickBooks Sales
Rep First Name (25)
Figure 24

Changes are passed from Tabs3 to QuickBooks.
Changes are not passed from QuickBooks to Tabs3.
Tabs3 will add a lookup record to QuickBooks if a
matching record does not exist.
If the Tabs3 timekeeper has no initials, the client will not
be added to QuickBooks.
Changes made in Tabs3 are not passed to QuickBooks.
Changes made in QuickBooks are passed to Tabs3, but
only updates the Primary Timekeeper field.
If no Sales Rep is specified in QuickBooks, the client will
not be added to Tabs3.
Sales Reps added through QuickBooks must exist as
timekeepers in Tabs3 or the client will not be added.
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Tabs3
Client_ID (13)
Figure 21

QuickBooks

Notes

Account Number (99) If no Account Number is specified in QuickBooks, the
Figure 22
client will not be added to Tabs3.
In order to integrate Jobs, both the Customer and the
Job must have an Account Number specified in
QuickBooks.
A numeric, alpha, or mixed key type can be used.

Date_Opened (10)
Figure 25

Job Start Date (10)
Figure 26

If no Work Description is specified in Tabs3, this field is
not passed to QuickBooks.
New Customers and Jobs added in QuickBooks without a
Job Start Date will merge into Tabs3 with a Date Opened
of the current system date.
Changes made in Tabs3 are not passed to QuickBooks.
Changes made in QuickBooks are passed to Tabs3.

Date_Closed (10)
Figure 25

Job End Date (10)
Figure 26

If no Work Description is specified in Tabs3, this field is
not passed to QuickBooks.
New Customers and Jobs added in QuickBooks without a
Job End Date will merge into Tabs3 with a Date Closed of
mm/dd/yyyy.
Changes made in Tabs3 are not passed to QuickBooks.
Changes made in QuickBooks are passed to Tabs3.

Billing Category Desc (30)
Figure 27

Job Type (31)
Figure 28

Tabs3 will add a lookup record to QuickBooks if a
matching record does not exist.
Jobs added through QuickBooks must be assigned a Job
Type that exists as a Tabs3 Billing Category.
If you create a Customer and a Job in QuickBooks and
want the same Category assigned to both, you must do
the following: Add the customer and assign a Job Type.
Then, add a Job and assign it the same Job Type.
Changes made in Tabs3 are not passed to QuickBooks.
Changes made in QuickBooks are passed to Tabs3.
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Cost File Screenshots
The following screenshots depict the comparable field names between Tabs3 Billing and
QuickBooks.

Figure 29, Tabs3 Cost

Figure 30, QuickBooks Bill
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Fields in the Cost File
The following table contains a complete listing of integrated fields. If a field is not listed, that field
does not integrate between programs.

Tabs3
1

Client/Work Description

QuickBooks
Customer Job

Notes
Valid entity required in order for transactions to be
passed.
Customer must have name, acct #, category (Job Type)
and timekeeper (Sales Rep).

2

Date

Date

3

Tcode

Class

Tabs3 tcodes must have alpha codes.

4

Bill Code

N/A

Tabs3 Billable costs are passed to QuickBooks as
billable.
Tabs3 Non-billable costs are passed to QuickBooks as
non-billable.
Billable QuickBooks Bills are passed to Tabs3 as billable.
Non-billable QuickBooks Bills are passed to Tabs3 as
billable.
Note: In QuickBooks 2012 Premier and prior, nonbillable costs integrate from QuickBooks to Tabs3 as
non-billable.

5

QuickBooks Vendor

Vendor

Tabs3 costs without a QuickBooks Vendor assigned will
be passed to QuickBooks with a vendor of “STI-Vendor”.

6

QuickBooks DB Account

Account

Tabs3 costs without a QuickBooks Account are passed
to QuickBooks with a Debit Account of “STI-Expense”
(regardless of whether it is a Tabs3 expense or
advance).
The QuickBooks Credit Account is always Accounts
Payable.

7

Amount

Amount

Tabs3 costs with 0.00 amount are passed to QuickBooks
as a Paid Bill.

8

Description (5000)

Memo (4095)

RTF attributes stripped from QuickBooks.

9

Date Entered

N/A

The Date Entered field will be passed to Tabs3 as the
date the Merge QuickBooks Data with Tabs3 is run.

N/A

The User ID field will be passed to Tabs3 with the User
ID that ran the Merge QuickBooks Data with Tabs3.

10 User ID
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Index
A
Accounts Receivable Balances
Adding
clients
costs
Adjustment of Payments
Application Certificate
Archived Transactions

31
36
36
30
10
31

B
Backing Up Data
Backup
best practices
Best Practices
adding costs
adding or changing clients
changing costs
deleting clients
deleting costs
deleting payments

40
9
36
36
36
36
36
36
36

renaming contacts
Configuring
class tracking
Employee List
integration
QuickBooks for integration
QuickBooks to assess sales tax
sales tax in QuickBooks
sales tax in Tabs3
Tabs3 clients
Tabs3 for integration
transaction codes for integration
verifying customer information
Cost Integration
in QuickBooks
in Tabs3
Tabs3 cost credits
Tabs3 notes
Cost Recovery Software
integration with QuickBooks
Credit Memos in QuickBooks
Customer Account Number
verifying
Customization Window
configuring for integration

C
Certificate
Changing
clients
costs
Class Tracking
setting up
Client Funds
Client Integration
in Tabs3
Tabs3 integration notes
Clients
configuring clients for integration
disabling integration

39
20
20
9
19
21
21
17
14
12
15
19
33
28
29
29
38
33
19
12

D
10
36
36
20
31

Deleting
clients
costs
payments
Differences in Terminology
Disabling Integration

27
27
14
14

36
36
36
8
24

E
Employee List in QuickBooks
Error Messages
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F
Fees
Field Mapping
client file screenshots
cost file screenshots
fields in the client file
fields in the cost file

31
43
43
49
46
50

G
General Journal Entry Window in QuickBooks 30
General Ledger Software
integration with QuickBooks
37
Getting Started
23
GLS
See General Ledger Software

Integration
Accounts Payable Software and
QuickBooks
best practices
cost recovery software and QuickBooks
General Ledger Software and QuickBooks
items that do not integrate
other Tabs3 products and QuickBooks
PracticeMaster and QuickBooks
Tabs3 Connect and QuickBooks
Tabs3 Remote and QuickBooks
Trust Accounting Software and
QuickBooks
Integration Configuration
Integration Overview
chart
QuickBooks to Tabs3 Billing
Tabs3 Billing to QuickBooks
Integration Requirements

37
36
38
37
31
37
37
38
38
37
9
7
7
7
7
8

J
H
Help
How QuickBooks Integrates with Tabs3
How Tabs3 Integrates with QuickBooks

41
32
26

Job Type
verifying

19

K
I

Knowledge Base

Implementation Scenarios
23
bringing QuickBooks information to
Tabs3
23
data exists in both Tabs3 and QuickBooks 24
disabling integration after data merge
24
posting Tabs3 database to QuickBooks
23
Inactive Clients
28
Initial Integration
24
Merge Count
25
QuickBooks Application Certificate
10
Tabs3 File
25

6, 41

M
Merge Count
Merge QuickBooks Data with Tabs3
Multi-User Mode
limitations
switching to Single-user mode
Multi-user Mode vs. Single-user Mode
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O
Overview of Integration

7

P
Payment Integration
General Journal Entry window
payment adjustments
payment refunds
payment reversals
PracticeMaster
integration with QuickBooks
Progress Billing

29-30
30
31
31

32
19
33
33
32
32
9
9
9
10

R
RDS
Remote Data Sharing
Renaming Contacts
Rep
verifying
Reports
Detail Work-in-Process Report

34
34
35
35
35
41
41
41
41
31
31

S
37
32

Q
QuickBooks
client integration
configuring for integration
cost integration
credit memo integration
how QuickBooks integrates with Tabs3
integration with Tabs3
multi-user mode
multi-user mode vs. single-user mode
single-user mode
QuickBooks Application Certificate

reporting data from QuickBooks
Task Code Billing Report
Transaction Code List
Transaction File List
verification lists
Resources
Help
Knowledge Base
Web Site
Reversal of Payments
Reversal of Refunds

40
40
39
19
34

Sales Tax
configuring in QuickBooks
configuring in Tabs3
Secure Clients
Send Tabs3 Data to QuickBooks
Single-User Mode
switching to multi-user mode
STQBERR.LOG

21
17
28
25
9
26

T
Tabs3
client integration
27
configuring integration in Customization 12
configuring clients for integration
14
configuring for integration
12
configuring sales tax
17
cost integration
28
how Tabs3 integrates with QuickBooks 26
integration with QuickBooks
26
payment integration
29
Tabs3 Connect
integration with QuickBooks
38
Tabs3 File
25
Tabs3 Remote
integration with QuickBooks
38
TAS
See Trust Accounting Software
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Tcodes
See Transaction Codes
Technical Considerations
39
backing up data
40
renaming contacts
39
Undo Updated Statements
39
Terminology Differences
8
Third Party Integration Requirements
8
Transaction Codes
configuring for integration
15
Troubleshooting
40
Trust Accounting Software
integration with QuickBooks
37
Types of Integration
25

U
Undo Updated Statements

39

V
Version Compatibility

8

W
Web Site
Work Description
Write Offs

6, 41
27
32
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